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Preface

Welcome to the Oracle Customer Relationship Management, Release 11.5.2, suite
of applications.

This Concepts and Procedures provides information and instructions to help you
work effectively with Oracle Network Logistics.

This preface explains how Concepts and Procedures is organized and introduces
other sources of information that can help you.

Intended Audience

This guide is aimed at the following users:

Technical Service Representatives (TSR)
Customer Service Representatives (CSR)

System Administrators (SA), Database Administrators (DBA), and others with
similar responsibility.

This guide assumes you have the following pre-requisites:

Understanding of the company business processes.
Knowledge of products and services as defined by your marketing policies.
Basic understanding of Oracle and Developer/2000.

Background in SQL, PL/SQL, SQL* Plus programming.

xi



Structure

This manual is a compilation of the topics in the online help for Oracle Network
Logistics. It contains the following sections:

“Understanding Oracle Network Logistics” provides overviews of the application
and its components, explanations of key concepts, features, and functions, as well as
the application’s relationships to other Oracle or third-party applications.

“Using Oracle Network Logistics” provides process-oriented, task-based
procedures for using the application to perform essential business tasks.

“Implementing Oracle Network Logistics” provides general descriptions of the
setup and configuration tasks required to implement the application successfully.

“Administering Oracle Network Logistics” provides task-based procedures for
required for ongoing system maintenance and includes information on
administration tools and utilities.

Related Documents

Xii

For more information, see the following manuals:
= Oracle Inventory User’s Guide

= Oracle Purchasing User’s Guide

= Oracle Assets User’s Guide

= Oracle Projects User’s Guide

= Oracle Payables User’s Guide



Understanding Oracle Network Logistics

This topic group provides overviews of Oracle Network Logistics and its
components, explanations of key concepts, features, and functions, as well as the
application’s relationships to other Oracle or third-party applications.

Overview of Oracle Network Logistics

Oracle Network Logistics is a tracking system that integrates with and stores
information collected from Inventory, Purchasing, Projects, Assets, and Payables.

With Oracle Network Logistics, you can give users access to tracking information
without allowing them access to sensitive processes related to assets and
purchasing. You can also track inventory items after they have been installed and
link financial transactions to the physical movement of equipment.

Oracle Network Logistics Supports These Functions

This application supports the standard functions found in Oracle Inventory, Oracle
Purchasing, Oracle CRL-Financials Enabled Assets, and Oracle CRL-Financials
Enabled Projects, with the exception of those listed under Functions Not Supported
by Oracle Network Logistics.

Oracle Network Logistics supports the following functions:

= Receipt of depreciable items into depreciable expense subinventories,
without a project

= Receipt of normal items into operating projects and expense subinventories
= Cycle count and physical inventory adjustments
= Receipt of normal items into asset subinventories, without a project

= Issue of items to an operating project

Understanding Oracle Network Logistics 1



Understanding Inventory Item and Asset Tracking

= Installation of equipment from a workforce management system

= Subinventory transfers

= Inter-organization transfers

= Miscellaneous receipts and issues

= Placement of assets into or out of service

= Retirement and Reinstatement of assets

= Invoice cost adjustments to project expenditure lines and asset costs

s ltem moves

Functions Not Supported by Oracle Network Logistics
Oracle Network Logistics does not support the following functions:

= Internal order issue

= Internal order transfer

= Work in process (WIP) assembly return

=  WIP component return

=  WIP component issue

= Sales order issue

= Return to vendor

= Return from vendor

= Receipt of a depreciable item directly to an operating project
= Receipt of a normal item into an expense subinventory

= Miscellaneous receipt of a depreciable item with a serial number

Oracle Network Logistics does not support Oracle Project Manufacturing.

Understanding Inventory Item and Asset Tracking

To track inventory items and assets, Oracle Network Logistics must interact with
several enterprise resource planning (ERP) applications. It sends to and receives
messages from those applications about the status and location of the items you
want to track.

2 Oracle Network Logistics



Understanding Inventory Item and Asset Tracking

The arrows in the Overview of Message Flows in Oracle Network Logistics diagram
show how messages flow back and forth between Network Logistics and ERP
applications. Specific events automatically trigger most of these messages. Messages
may be sent manually when an interfacing system must be adjusted.

Oracle Payables

Oracle Purchasing

Oracle Inventory
A /_\A Cracle Inventory

Oracle MNetwiork

Logistics
Integration Pack

& COracle Assets
Workforce

Ianagement /
Oracle Projects

Overview of Message Flows in Oracle Network Logistics

Oracle Network Logistics acts as a hub, collecting information from and
distributing information to the various other applications. In fact, Network
Logistics is a systems integration pack that connects applications while residing in
an interim layer between the applications and the database. For a technical
overview of Network Logistics architecture, see Steps Before Implementation.

In the Overview of Message Flows in Oracle Network Logistics diagram, for
example, when a field service technician enters a report that a piece of equipment
has been placed into service, the Workforce Management System may send a
message to Network Logistics. This message updates the status of the equipment to
“In Service,” and gives its in-service date to Oracle Projects The asset is now ready
to be created in Oracle Assets.

Understanding Oracle Network Logistics 3



The Messaging Architecture in Oracle Network Logistics

The Messaging Architecture in Oracle Network Logistics

The messaging architecture receives requests from external publishing systems in
XML (eXtensible Markup Language) format. Based on the input requirements, the
application updates the status and keeps a history of transactions for the tracking
unit. Subsequently, the application publishes outgoing requests to the subscribing
systems for further processing. The publishing and subscribing systems include:
inventory, purchasing, accounts payable, fixed assets, project accounting, workforce
management, and network inventory systems.

Understanding Network Logistics Trackable Items

An asset comprises a collection of items. The items may be trackable or not
trackable. During implementation, items are designated as Network
Logistics-trackable at the master level in Oracle Inventory. Oracle Network Logistics
tracks the activity of the trackable items through inventory, projects, and into fixed
assets.

In Oracle Assets you perform the Mass Additions concurrent process to create
assets.

Understanding the Item Unit and Transaction Records

When an item is initially received, typically via a purchase order, a receipt
transaction occurs. The initial receipt transaction creates a unit record for the item.
The receipt transaction record is associated to the item unit record. Subsequent
transactions against this item will also be associated with the unit record and will
make up the "history" for that record.

Types of Transactions
Possible transactions types include:

s PO Receipt

= Issue Item to project
= Equipment Installed
= Equipment In-Service
= Item Move

s Asset Out-of-Service

4 Oracle Network Logistics



Items in Depreciable Inventory

= Asset In-Service

= Miscellaneous issue

= Miscellaneous receipt
= Subinventory transfer
= Inter-Org transfer

= Asset Retirement

s Asset Reinstatement

Note: A fatal error occurs if Network Logistics does not have an
item record for a depreciable item that is received with a
miscellaneous receipt. See Understanding the Error Log.

Unit Record Statuses
Possible statuses include:

= InInventory

= In Depreciable Inventory

= InTransit

= Issued to project

= Miscellaneous Issued

= Installed

= InService

= Out of Service

= Retired

Your enterprise may modify the name of any pre-defined status to fit your needs.

Your enterprise may modify the name of any pre-defined status to fit your needs.

Items in Depreciable Inventory
When a depreciable item is received, Network Logistics:

= Creates an item record with a status of In Depreciable Inventory.

Understanding Oracle Network Logistics 5



Understanding Move Orders

= Inserts a record in the interface table for Oracle Assets and automatically
submits "post mass-addition."

» Stores the asset distribution ID in the item record

Depreciable inventory is designated at the subinventory level. Depreciable
subinventories are expense subinventories that contain depreciable items.

The cost assigned to depreciable assets is derived from the purchase order. When
Accounts Payable processes the invoice, Network Logistics automatically adjusts
the asset cost.

See also:
= Receiving Depreciable Items into Expense Subinventories

= Guidelines to Managing Negative Inventory

Understanding Move Orders
A move order transfers inventory:
= From one stocking location to another
= From astocking location to a project

To create a move order, you manually create a move order requisition. Once the
move order requisition is approved, it becomes a move order. If the organization
does not require approval, the manual request automatically becomes a move order.

Network Logistics uses the following types of move orders:

= Network Logistics Move Order Issue to Project, to create a document for
moving material from inventory to a project

= Network Logistics Move Order Subinventory Transfer, to create a document
for moving material from one subinventory to another subinventory. See
Understanding Subinventory Transfers.

Parts of a Move Order
A move order comprises three parts:

= The Move Order Header holds the move order number, an optional description
of the move order, and information to default to the individual move order
lines.

6 Oracle Network Logistics



When to Use Miscellaneous Receipts

= The Move Order Lines are the actual move requests, including: the item
number, requested quantity, completed quantity, the source and destination
information.

= The Line Details are the inventory transactions that occur to fulfill a move
order line, including: equipment code (CLEI), serial number, quantity moved,
source and destination details (such as locators).

Move Order Approval Governed by Time-Out and Item Planner

At the organization level, three attributes—Move Order Time-out Period, Time-out
Action, and Item Planner item-affect how move order requisitions are approved. If
the move order requisition is not approved before the time-out period passes,
Oracle Workflow sends a reminder notice to the item planner. If the move order
requisition is still not approved within a second time-out interval, the requisition is
automatically approved or rejected based on the Time-out Action setting. If no item
planner is specified for the item, the requisition line is approved automatically.

Understanding Miscellaneous Transactions

Oracle Network Logistics supports the miscellaneous transactions—-receipts and
issues—used by Oracle Inventory. Each transaction in Inventory triggers a message
to Network Logistics.

For depreciable items, if the quantity for the Network Logistics unit record is
reduced to zero, then the fixed asset distribution line for that item/location is
deleted. Network Logistics does not adjust asset units in Fixed Assets to a number
less than one. Network Logistics does not adjust asset units to a number less than
zero. If the transaction would cause a negative balance, Network Logistics adjusts
the assets distribution lines only to zero.

See also:
= When to Use Miscellaneous Receipts
= Understanding Miscellaneous Issues

= Guidelines to Managing Negative Inventory

When to Use Miscellaneous Receipts

Use miscellaneous receipts to receive material without a purchase order number.
Oracle Network Logistics uses the same process for performing a miscellaneous

Understanding Oracle Network Logistics 7



Understanding Miscellaneous Issues

receipt as the process used in standard Oracle Inventory. You may also need to enter
an equipment code (CLEI) in the Lot field, or a serial number.

For Normal ltems

If no matching record already exists in the unit table, Network Logistics creates a
record for the item. The record contains an item status of In Inventory and a
transaction status of Complete. If the item already has a record with an item status
of In Inventory, Network Logistics increments the quantity for the record.

For Depreciable Iltems

Network Logistics looks for and updates a record. If the record does not exist (such
as, first time receipt), a fatal error occurs.

In addition, the application determines the fixed asset location ID for the
subinventory that is associated with the receipt transaction. If a distribution line
already exists, Network Logistics adjusts the units of that line.

Note: Whether or not the item has a serial number, the asset cost
remains unchanged.

For more information, see Oracle Inventory User’s Guide: Performing Miscellaneous
Transactions and Oracle Assets User’s Guide: Defining Locations and Defining
Distributions.

Understanding Miscellaneous Issues

In Oracle Network Logistics, the process for performing a miscellaneous issue is the
same as the process used in standard Oracle Inventory. In addition, you can enter
the equipment code (CLEI) in the Lot field and a serial number for serial and lot
controlled items.

Unit Status

For normal items, the status in the unit table must be In Inventory. For depreciable
items, it must be In Depreciable Inventory.

For Normal ltems with Serial Numbers
The application:

= Sets the item status in the unit table to Miscellaneous Issue.

8 Oracle Network Logistics



Understanding Miscellaneous Issues

= Creates a Miscellaneous Issue transaction status record.
For Normal Iltems without Serial Numbers

The application:

= Decrements the quantity in the unit table record.

s Creates a Miscellaneous Issue transaction record.

For Depreciable ltems with Serial Numbers
The application:

= Determines the fixed asset location ID for the subinventory that is used in the
miscellaneous transaction.

= Determines the fixed asset distribution ID and the corresponding asset in Oracle
Fixed Assets.

s Creates a Miscellaneous Issue transaction record with the status of
"Incomplete.”

Since depreciable items have companion asset records, the application also
generates a workflow notification that advises you to fully retire the asset. When
this full retirement transaction is completed in Oracle Fixed Assets, the transaction
record status will be set to "Complete" and the unit record status to "Retired.”

Note: If you have mistakenly miscellaneously issued the total
quantity of a depreciable item, then you can reverse the transaction
by first completing the full retirement and then reinstating the
asset. The asset reinstatement reverses the operation of the
Network Logistics retirement logic.

The retirement transaction is not generated automatically. You must manually
perform the retirement transaction.

For Depreciable ltems without Serial Numbers
The application:

= Determines the fixed asset location ID for the transaction subinventory.

= Determines the fixed asset distribution ID and the corresponding asset in Oracle
Fixed Assets.

= Decrements the unit quantity of the asset distribution line.

Understanding Oracle Network Logistics 9



Understanding Subinventory Transfers

Note: The asset cost is not adjusted.

For more information, see Oracle Inventory User’s Guide: Performing Miscellaneous
Transactions and Oracle Assets User’s Guide: Defining Locations and Defining
Distributions.

Understanding Subinventory Transfers

A subinventory transfer moves material inventory between subinventories. A
subinventory is a unique physical or logical separation of material inventory, such
as raw inventory, finished goods or defective material. All material within an
organization is held in one or more subinventories.

A move order initiates a subinventory transfer. Oracle Network Logistics handles
these transfers in the same manner that Oracle Inventory handles them.

For more information on how subinventory transfers are processed, see Basic
Processing of Subinventory Transfers.

For information on move orders, see Understanding Move Orders.

Basic Processing of Subinventory Transfers

The way Network Logistics processes a subinventory transfer is based initially on
whether or not the transferred item has a serial number.

Iltem with a Serial Number

Network Logistics searches the database for the From record associated to the item.
This record must have a status of In Inventory or In Depreciable Inventory and a
transaction status of Complete. Once Network Logistics locates the record, it
updates the item’s subinventory in the From record.

Item without a Serial Number

Network Logistics searches the database for the From and To records. These records
must have a status of either In Inventory or In Depreciable Inventory and a
transaction status of Complete. Once Network Logistics locates the records, it
updates the item’s subinventory in both the From and To records.
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Subinventory Transfers of Depreciable Items

To and From Subinventory Status Must Be Compatible

A subinventory may have a status of either Depreciable or Normal. An item can
only be transferred between subinventories that have the same status. Items cannot
be transferred from Depreciable to Normal subinventories, or vice versa. If the
status of the From subinventory does not match the status of the To subinventory,
the application generates an error.

See also Subinventory Transfers of Depreciable Items.

If a To Record Does Not Exist

If the application cannot find a To record, it creates a new record. The record has a
status that matches the status of the From Record, either In Inventory or In
Depreciable Inventory.

If a From Record Does Not Exist

If the application cannot find a From record for the item being transferred, it
generates an error.

Subinventory Transfers of Depreciable Items

To transfer a depreciable item, at least two subinventories must exist which are
designated as both depreciable and expense. The item number must be defined in
Oracle Inventory.

When a depreciable item is transferred from one subinventory to another and the
subinventories are in different physical locations, the transfer may require a change
in the fixed asset distribution lines. In this circumstance, the changes that are made
to the item record depend on whether or not the item has a serial number.

Depreciable Item with a Serial Number
The application:

= Retrieves the fixed asset location of the subinventory from which the item is
being transferred (From inventory)

= Retrieves the fixed asset location of the subinventory to which the item is being
transferred (To inventory)

= Updates the item record with the new fixed asset distribution ID

= Updates the item record with the subinventory to which it is transferred.
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Understanding Inter-organization Transfers

If the subinventory transfer of a depreciable item with a serial number does not
require a change in the fixed asset distribution lines, the application updates the
item quantity in the subinventory to which it is transferred.

Depreciable Item without a Serial Number
The application:

= Retrieves the fixed asset location of the subinventory from which the item is
being transferred (From inventory)

= Retrieves the fixed asset location of the subinventory to which the item is being
transferred (To inventory)

= Transfers the asset distribution to the To record
= Adjusts the quantities on both the From and To records

If no change in fixed asset distribution is required, the application updates the item
guantities on the From and To records.

Understanding Inter-organization Transfers

An inter-organization transfer moves items between organizations. This transfer
may be either a Direct or an In Transit transaction.

Direct vs. In Transit Transactions

In a Direct transaction, the shipping organization transfers the item into a
subinventory in the receiving organization. For this reason, the application treats a
Direct inter-organization transfer the same as a subinventory transfer.

For an In Transit transaction, the monetary value of the transferred item is
deposited in an in-transit account and the inventory account of the shipping
organization receives credit for the item. Upon receipt of the transferred item, the
receiving organization must perform a receipt transaction to bring the item into its
inventory. The receipt transaction credits the in-transit account and debits the
inventory account of the receiving organization.

Inter-organization Transfers Tied to Oracle Inventory

Oracle Network Logistics uses the same process that Oracle Inventory uses to
transfer materials between organizations. Before items can be transferred, items
must be defined and subinventories must be created in Oracle Inventory.
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Inter-organization Transfers of ltems with Serial Numbers

If the organization from which the item is being transferred does not allow negative
inventory balances, it must contain sufficient on-hand inventory for the transaction
to occur.

See also Initial Step to Processing Inter-organization Transfers.

Initial Step to Processing Inter-organization Transfers

If the inter-organization transfer is a Direct transaction, the application treats it the
same as a Subinventory transfer.

If the inter-organization transfer is an In Transit transaction, the application
searches the database for the From record associated to the item. This record must
have a status of In Inventory or In Depreciable Inventory and a transaction status of
Complete. If the item fails to meet these conditions, it generates an error message.

There is no difference, from an Network Logistics perspective, between a FOB
Shipment or FOB Receipt type transaction.

See also:

= Inter-organization Transfers of Items with Serial Numbers

= Inter-organization Transfer of Items without Serial Numbers
= Understanding Inter-organization Transfers

= Understanding Subinventory Transfers

Inter-organization Transfers of Items with Serial Numbers

The In-transit transfer of an item with a serial number from one organization to
another, the application follows these steps:

= In-transit Shipment
The source record for the From organization and subinventory will be located.
Then it will be updated with status "In-Transit" and the To organization. The
subinventory information will be removed from the record. If the item is
depreciable, the source FA location will be determined by the From
organization and subinventory, and the destination FA location will be
determined by the To organization only. If they are different, the FA
distribution transfer APl will be invoked to perform a distribution transfer in
Fixed Assets. The distributions stored in the Network Logistics records will also
be updated
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Inter-organization Transfers of ltems without Serial Numbers

In-transit Receipt

When the item reaches its destination, someone enters a receipt transaction for
the item. The "In-transit" record with the To organization will be located. It will
then be updated with status "In Inventory" or "In Depreciable Inventory" if it is
depreciable and the To subinventory. If the item is depreciable, the source FA
location will be determined by the organization in the "In-transit" record, and
the destination FA location will be determined by the To subinventory in the To
organization. If they are different, the FA distribution transfer API will be
invoked to perform a distribution transfer in Fixed Assets. The distributions
stored in the Network Logistics records will also be updated.

In all of the above cases, if the transaction status of the record being processed is
‘Incomplete’, any data change will be rolled back and the message will be inserted
into the Redo Log. If the transaction is successfully processed, transaction records
will be created to store the transaction history.

To and From Subinventory Status Must Be Compatible

A subinventory may have a status of either Depreciable or Normal. An item can
only be transferred between subinventories that have the same status. Items cannot
be transferred from Depreciable to Normal subinventories, or vice versa. If the
status of the From subinventory does not match the status of the To subinventory,
the application generates an error.

Inter-organization Transfers of Items without Serial Numbers

The In-transit transfer of an item without a serial number from one organization to
another, the application follows these steps:

In-transit Shipment

The source record for the From organization and subinventory will be located
and the quantity will be subtracted by the transaction quantity. An "In-Transit"
record will then be created with the destination organization and transaction
guantity. No subinventory information will be kept in this record. If such a
record already exists, the quantity will be increased by the transaction quantity.
If the item is depreciable, the source FA location will be determined by the
From organization and subinventory, and the destination FA location will be
determined by the To organization only. If they are different, the FA
distribution transfer APl will be invoked to perform a distribution transfer in
Fixed Assets. The distributions stored in the Network Logistics records will also
be updated
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Understanding Adjustments

= In-transit Receipt
When the item reaches its destination, someone enters a receipt transaction for
the item. The "In-transit" record with the To organization will be located. The
quantity will be subtracted with the transaction quantity. The destination
record will be located based on the To organization and subinventory. If the
record exists, the quantity will be increased by the transaction quantity. If there
is no such record, a new destination record will be created. If the item is
depreciable, the source FA location will be determined by the organization in
the "In-transit" record, and the destination FA location will be determined by
the To subinventory in the To organization. If they are different, the FA
distribution transfer APl will be invoked to perform a distribution transfer in
Fixed Assets. The distributions stored in the Network Logistics records will also
be updated.

In all of the above cases, if the transaction status of the record being processed is
‘Incomplete’, any data change will be rolled back and the message will be inserted
into the Redo Log. If the transaction is successfully processed, transaction records
will be created to store the transaction history.

To and From Subinventory Status Must Be Compatible

A subinventory may have a status of either Depreciable or Normal. An item can
only be transferred between subinventories that have the same status. Items cannot
be transferred from Depreciable to Normal subinventories, or vice versa. If the
status of the From subinventory does not match the status of the To subinventory,
the application generates an error.

See also:
= Understanding Inter-organization Transfers
= Initial Step to Processing Inter-organization Transfers

= Inter-organization Transfers of Items with Serial Numbers

Understanding Adjustments
Use an adjustment to add a new record in Network Logistics

or to correct an existing record. Use the adjustment window only when you need to
update the Network Logistics records so that they match the corresponding records
in Oracle Assets, Oracle Purchasing or Oracle Inventory.

An unexpected system error can interrupt communication between Network
Logistics and other modules, such as Oracle Assets, Oracle Purchasing, or Oracle
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Understanding the CLEI

Inventory. As a consequence, Network Logistics records may not be created or may
contain incorrect quantity information.

For example, you want to issue 10 items, but accidentally enter 19 on the
transaction. You cannot delete the record that contains the incorrect quantity, but
you can make an adjustment to the quantity associated with an existing record in
the Adjustment window. After you correct the record in the Adjustment window,
you can also delete the associated message of the incorrect record that is in the Redo
Log.

See also:
= Making an Adjustment
= Understanding the Redo Log

Understanding the CLEI

The Common Language Equipment Identifier (CLEI) is a vendor-specific,
10-character code. It is a standard used by the telecommunications industry for
identifying and describing equipment. Because Oracle Network Logistics captures
the CLEI code in the lot field, items that have a CLEI code must be set to full lot
control. If an item has no CLEI code, it does not need lot control.

The supplier usually provides CLEI codes for the items you purchase. When
performing transactions, you may select CLEI codes from a list of values, or you
may enter new CLEI values directly into the Lot field.

See also:

Defining Vendor Equipment Codes (CLEI).

Overview of Retirements

The process that Network Logistics uses to retire and reinstate assets is the same as
the process used in Oracle Assets, except that with Network Logistics you may only
retire or reinstate whole assets. Partial retirements are not supported.

Before you retire an asset, you must first take it out of service. If the asset being
retired is in a depreciable subinventory, Network Logistics generates a
miscellaneous issue transaction for the item and quantity. It then updates the item’s
status to Retired.

Asset must have a status of retired before they can be reinstated. An asset
reinstatement reverses the operation of the Network Logistics retirement logic. For
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Guidelines to Managing Negative Inventory

the reinstatement, Network Logistics generates a miscellaneous receipt transaction
for the item and quantity and then updates the unit record status to
"Out-of-Service".

Guidelines to Managing Negative Inventory

Negative inventory balances are most often caused by inventory discrepancies,
where the quantity or physical location of the item shown in the system is not
correct. Such discrepancies are often the result of;

= Achange in physical inventory that is not accompanied by a supporting
transaction or the transaction is delayed

= A data entry error in the transaction

To determine if any items have negative on-hand balances, you can generate a
report of only those items with negative on-hand quantities.

Negative Inventory Defined by Organization Setup

Each organization chooses whether or not to allow negative inventory balances as
part of the organization setup. Some organizations choose to allow negative
inventory balances so that the transactions may be entered into the system and
negative quantities researched. Since you cannot physically have less than zero
guantity on hand, some organizations choose not to allow negative balances
because they misrepresent reality.

Handling Depreciable Inventory

If an organization has depreciable inventory, it must give careful consideration to
whether or not negative inventory balances are permitted. If the organization’s
requirements allow negative balances, then depreciable subinventories must be
carefully monitored to make sure that the on-hand information for items being
depreciated is accurate.

Another option is to create a separate organization for depreciable inventory where
negative balances are not allowed. This option ensures that the on-hand balances of
depreciating items do not fall below zero. The use of two organizations for
inventory requires a higher volume of move orders and inter-organization
transfers.

While inventory can handle negative balances, assets cannot. Therefore, Network
Logistics cannot adjust the units on the asset distribution below zero. If the
inventory balances of a depreciable item at a location reaches zero, the Network
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Physical Inventory Adjustments

Logistics unit record will have a quantity of zero and the asset distribution line for
that location will be deleted.

Physical Inventory Adjustments

A physical inventory occurs when a person verifies that units exist physically and
that the quantities match the on-hand records in Network Logistics. Based on the
results of physical inventory, Network Logistics supports adjustments that you
make to your inventory balances. Depending on the type of inventory adjustment
necessary, Network Logistics treats these adjustments like a miscellaneous
transaction.

Overview of Network Logistics Requests

You can run the following reports, requests, and concurrent processes in Network
Logistics:

= Network Logistics Assumed Loss Rate Report

= Network Logistics Bill of Lading Report

= Network Logistics Error Log Report

= Import Vendor Equipment codes

= Import Network Locations

= Network Logistics Redo Log Report

=« Initial Load

s PRC: Interface Payables Cost Adjustments to Assets
= PRC: Interface Payables Cost Adjustments to Projects

= Network Logistics Recovery Process

Understanding the Network Logistics Assumed Loss Rate Report

Use this report to see a detailed or summarized report of material transaction
information for items that have been issued to projects but have not been installed.
You can research the items on this report to determine whether they should be
installed and placed in service or returned to inventory.

See also:
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PRC: Interface Payables Invoice Cost Adjustments to Assets

Requesting a Network Logistics Assumed Loss Rate Report

Understanding the Network Logistics Bill of Lading Report

Use this report to generate a bill of lading that may be used as a packing slip when
you ship material to a project. You can use features in Network Logistics to ship
material to project sites.

See also: Requesting a Network Logistics Bill of Lading Report

Understanding the Network Logistics Error Log Report

Use this report to review a list of all transactions which had fatal errors. A fatal error
can occur when:

= Theitem in a transaction has undefined attributes

= The transaction is a miscellaneous receipt, the item is depreciable and has no
record in Network Logistics

= A record should exist and Network Logistics cannot find it

A transaction with a fatal error cannot be processed. Until the transaction is
corrected, any subsequent transactions for the same item also generate a fatal error.

The Error Log may also contain information about messages that are related to
recoverable errors that are found on the Redo Log Report.

See also:
= Requesting a Network Logistics Error Log Report

= Network Logistics Redo Log Report

PRC: Interface Payables Invoice Cost Adjustments to Assets

Use this concurrent program to send invoice variances to Oracle Assets. This
ensures that the asset records for depreciable items show a value that is as close to
the actual purchase price as possible.

See also:

Running a Concurrent Program
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PRC: Interface Payables Invoice Cost Adjustments to Projects

WARNING: User MUST always run this process before running
the standard AP to FA process, PRC: Interface supplier invoices
to assets.

PRC: Interface Payables Invoice Cost Adjustments to Projects

Use this concurrent program to update projects with Invoice Price Variance (IPV)
amounts. IPV is the difference between the amount on the invoice and the price on
the purchase order line. This concurrent process ensures that the construction cost
of the project is as close to the actual cost as possible.

See also:

Running a Concurrent Program

Understanding Network Locations

A network location, also known as a Common Language Location Identifier (CLLI),
indicates a geographical location for an asset. Use the Import Network Locations
request to bring CLLI codes from a legacy system into Network Logistics.

See also:
= Importing Network Locations

s Associate Network Locations to Fixed Asset Locations

Understanding the Item Summary Window

The Item Summary window displays a brief summary of the results of an inquiry in
the Oracle Network Logistics responsibility. Each line in the window represents an
item record. Serialized items at the same location are summarized into a single line.
Use this window to see how items are distributed within the enterprise. Buttons at
the bottom of the window link to more detailed information.

See also:

= Asset/Network Details
= Project Details

= Inventory Details

= Performing an Inquiry in Network Logistics
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Understanding the Project Details Window

Understanding the Asset/Network Details Window

The Asset/Network Details window shows where a Network Logistics-trackable
item is being used in the enterprise. Most items in this window are in service or
installed as components of an asset. Buttons at the bottom of the window link to
more detailed information.

This window appears when you click Asset/Network on the Item Summary
window.

See also:
= Performing an Inquiry in Network Logistics

= Understanding the Item Summary Window

Understanding the Asset Details Window

The Asset Details window shows where a Network Logistics-trackable item is being
used in the enterprise. Most items in this window are in service or installed as
components of an asset. Buttons at the bottom of the window link to more detailed
information.

= Performing an Inquiry in Network Logistics

= Understanding the Item Summary Window

Understanding the Project Details Window

The Project Details window displays information about the project that is using an
item, including: item number, organization, serial number, quantity, location, install
date, transaction/issue date, status, project number, task, lot number, vendor serial
number, and reference. Buttons at the bottom of the window link to more detailed
information.

This window appears when you click In Process on the Item Summary window.
See also:
= Performing an Inquiry in Network Logistics

= Understanding the Item Summary Window
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Understanding the Inventory Window

Understanding the Inventory Window

The Inventory window displays inventory information about a selected item, such
as subinventory, lot number, revision, vendor serial number, and vendor name.

Buttons at the bottom of the window link to more detailed information.
See also:
= Performing an Inquiry in Network Logistics

= Understanding the Item Summary Window

Understanding the Transactions Window

The Transactions window displays the transaction history for a particular item. The
particular details displayed may be related to Inventory Transactions, Project
Transactions, or Asset Transactions.

See also:

= Performing an Inquiry in Network Logistics

= Understanding the Inventory Window

= Understanding the Project Details Window

= Understanding the Asset/Network Details Window
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Receiving Depreciable ltems into Expense Subinventories

Using Oracle Network Logistics

This topic group provides process-oriented, task-based procedures for using the
application to perform essential business tasks.

Receiving Depreciable Items into Expense Subinventories

Prerequisites

At least one subinventory must exist which is designated as depreciable and
expense. The item number must be defined in Oracle Inventory. The purchase order
must exist in Oracle Purchasing and have a status of Approved.

Steps

1.

In the Inventory responsibility, navigate to Transactions >Receiving > Receipts.
The Organizations window opens.
Choose your organization from the Organizations window and click Find.

In the Find Expected Receipts window, enter criteria that identifies the items
you are receiving, such as the purchase order number and item number, and
click Find.

The Receipt Header and Receipt Lines open to display items that match the
criteria entered.

In Receipt header, enter the packing slip number and other pertinent
information.

In Receipt lines, verify the quantity to be received.
You may receive a partial line quantity.

In Receipt lines, verify that the destination subinventory entered on the
purchase order is depreciable.

Click Lot-Serial.

If the item is under lot control, enter the equipment code (CLEI) in the Lot field.
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Receiving Normal Items Directly into an Operating Project

If the items are under serial control, enter individual serial numbers or a range
of consecutive numbers. You may also enter corresponding vendor serial
numbers in the Manufacturing Serial Number field.

8. Choose File >Save to complete the receipt.

Guidelines

Depreciable items must be received only into depreciable subinventories.

A fatal error will occur if depreciable items d are received into a subinventory that
is not flagged as depreciable. To ensure that they are received only to depreciable
subinventories, set up depreciable items with item/subinventory restrictions.

Note: A subinventory may hold only depreciable or normal items,
but not both.

References

See the description of subinventory and item setups during implementation of
Oracle Inventory.

Receiving Normal Items Directly into an Operating Project

A normal item is an item that is not depreciable. Use the following procedure to
receive a normal item into an operating project.

Note: A depreciable item cannot be received directly into a
project. Instead, it must be issued from Inventory.

Prerequisites

The purchase order must exist in Oracle Purchasing with a status of Approved. The
purchase order line must include:

= The project and task numbers for the item
= Theaccrue upon receipt flag must be unchecked
= The Expense destination type

The item number must be defined in Oracle Inventory. The project must be defined,
with a status of Active.

Steps

24  Oracle Network Logistics



Receiving Normal Items into Asset Subinventories

1. Inthe Inventory responsibility, navigate to Transactions >Receiving >
Receipts.

The Organizations window opens.
2. Choose your organization from the Organizations window and click Find.

3. Inthe Find Expected Receipts window, enter any criteria that identifies the
items you are receiving, such as the purchase order number and the item
number, and click Find.

The Receipt Header and Receipt Lines open to display items that match the
criteria entered.

4. In Receipt Header, enter the packing slip number and any other pertinent
information.

5. \erify that the Receipt line has a value for Deliver-to location.

When project information has been entered on the purchase order, the
Deliver-to location is defined and appears on this Receipt line.

Note: The Deliver-to location must be setup in the Network
Logistics Locations form and have an associated FA location.

6. Click Save to receive the item into the project and commit the receipt
transaction.

The application looks for an existing record for the item. If it locates a record
and the receipt transaction has processed successfully, it updates the item
record with the quantity received.

If the application does not find an existing record, it creates one for the receipt.
The application sets the unit’s status to In Inventory and its transaction status to
Complete.

Guidelines

Network Logistics does not support the receipt of depreciable items directly to a
capital project.

Receiving Normal Items into Asset Subinventories

A normal item is any item that is not a depreciable item. Use the following
procedure to receive a normal item into an asset subinventory.
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Managing Move Orders

Prerequisites

At least one subinventory must exist which has been designated as not depreciable
and asset. The item number must be defined in Oracle Inventory. The purchase
order must exist in Oracle Purchasing with a status of Approved.

Steps
1. Inthe Inventory responsibility, navigate to Transactions >Receiving > Receipts.

The Organizations window opens.
2. Choose your organization from the Organizations window and click Find.

3. Inthe Find Expected Receipts window, enter criteria that identifies the items
you are receiving, such as the purchase order number.

4. Inthe Receipt header, enter the packing slip number and any other pertinent
information.

5. Inthe Receipt lines, verify the quantity to be received.
You may receive a partial line quantity.

6. \erify that the destination subinventory entered on the purchase order is not
depreciable.

7. Click Lot-Serial.
If the item is under lot control, enter the equipment code (CLEI) in the Lot field.

If the items are under serial control, enter individual serial numbers or a range
of consecutive numbers. You may also enter corresponding vendor serial
numbers in the Manufacturing Serial Number field.

8. Choose File > Save to complete the receipt.

Managing Move Orders
In Network Logistics, you can:
= Create a Move Order
= Transact a Move Order

For more information about move orders, see Understanding Move Orders.
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Creating a Move Order

Creating a Move Order

Create a move order when you need to transfer inventory across subinventories or
into a project account. Use the following steps to create a move order.

Prerequisites

Inventory setups, such as item and subinventory definition, must be complete. At
least two transactions—-Subinventory Transfer and Issue to Project—-must also be
defined. If you use an Oracle Workflow process to route move order requisitions for
approval, the item must be assigned to an item planner.

Steps
1. Inthe Network Logistics responsibility, navigate to Transaction > NL Move
Order.

2. Inthe Move Order window, enter an order number in the Number field.

If you do not insert a value, the application fills the Number field. You may also
enter a description of the order in the Description field.

3. Inthe Default region, you enter the following information:

Transaction type. Select either Network Logistics Subinventory Transfer or
Network Logistics Issue to Project.

Required Date. Enter the requested delivery date
Also enter Ship-to Location, Source and Destination subinventories.
4. Enter the following information on the lines on each of the tabs:

= Item: the item number, item revision (if under revision control), quantity to
move

= Project and Task

= Source: source subinventory (if different from the default value), locator (if
locator control is enabled), equipment code (CLEI), and serial numbers. If
you do not know what subinventory the item should be transferred from,
click On Hand at the bottom of the window to search for material locations.

= Destination: the destination subinventory or account, if different from the
default value and the destination locator for a subinventory transfer type
move order
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Transacting a Move Order

= Control: the move order transaction type, if different from the default
value, a predefined reason code or alphanumeric reference information.

If approval is required, the item planner receives a Workflow notification that there
are move order requisition order lines awaiting approval. The planner uses Oracle
Workflow to approve the orders.

The item planner chooses Approve or Reject for each move order requisition line. If
one requisition line on a move order is rejected, other lines of the same move order
can be approved. Action defined on a move order line cannot be performed without
approval.

Transacting a Move Order

After a move order is approved, you transact the move order by performing the
action described on the approved lines. Use this procedure to perform the approved
transaction.

Prerequisites
The move order must be approved.

Steps
1. Inthe Navigator Logistics responsibility, navigate to Transactions > Move
Orders

2. Locate move orders that have been approved.
You can query by header, line, source, or destination information.

3. To add details to the move order line, check the Select box for each line you
wish to detail and click Location Details.

Information is automatically entered on the transaction lines of the move order,
based on the inventory picking rules and transaction defaults defined within
the organization.

4. Click View/Update to view the detailed lines.

You can manually update any information that is incorrect. Add missing
information, such as equipment code (CLEI) and serial numbers.

5. If you do not require a pick slip, click Transact to execute the detailed lines.

28 Oracle Network Logistics



Adding a New Record

If you need to print a pick slip, save the transaction at this point. When the pick
slip is ready, return to the Transact Move Orders window, select the line(s) to be
executed, and click Transact.

Making an Adjustment

In the Adjustment window, you can either update the quantity in an existing record
or create a new record.

See:

Adding a New Record
Updating the Quantity in an Existing Record

Understanding Adjustments

Adding a New Record

When a system error occurs, communication between Network Logistics and other
modules, such as Oracle Inventory, Oracle Purchasing, and Oracle Assets may be
interrupted. As a result, records for some items may be missing. Use the following
procedure to add a Network Logistics record to reconcile the application with the
records that exist in the other modules.

1.

In the Network Logistics responsibility, navigate to Transaction > Adjustment.

As an alternative, if you are currently looking at the Adjustments window, click
the New icon in the toolbar.

A blank record appears. You must enter information in the fields that are
yellow.

Enter the appropriate Inventory Item number, Organization and Status and
Quantity for with the new record.

If you enter a Status of In Inventory for the new record, only the Inventory tab
appears. If you enter another status, the Inventory and Asset tabs both appear.
When both tabs appear, you must enter information on both tabs.

Enter the following information on the Inventory tab:
= A pre-existing serial number
= The revision of the item

= The subinventory from which the item should be taken
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Updating the Quantity in an Existing Record

= The locator within the subinventory, if applicable
= Theequipment code (CLEI) associated to the item
= The vendor name

= The vendor serial number

On the Assets tab, enter the asset number and asset location fields, if this
information is available. When you enter this information, the other fields on
the Assets tab are automatically populated with related information.

4. Click Apply to save your work.
A message asks you to confirm the new record.

5. Click OK to confirm.

Guidelines

Items that have serial numbers must have a quantity of one. Items that do not have
serial numbers may have a quantity of zero or any whole number greater than zero.

Network Logistics links items and assets. When both the Inventory tab and the
Assets tab are available in the Adjustments window, enter information on both tabs.

Depending on the item attributes and status, some fields that are colored white on
the Inventory and Assets tabs may require information. An error message appears if
you try to save your work without supplying required information.

To create a complete record, enter as much information as possible, even in the
fields that are optional.

Updating the Quantity in an Existing Record

Use the following procedure to correct the quantity in an existing Network Logistics
record.

Prerequisites
A Network Logistics record must exist for the item.

Steps
1. Inthe Network Logistics responsibility, navigate to Transaction > Adjustment.

2. Enter the appropriate Inventory Item, Organization and Status associated with
the record.
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Performing an Inquiry in Network Logistics

Review the information in the Inventory, In Process or Assets tabs to verify that
you have the correct record.

Enter the correct quantity.

The record for an item that has a serial number may have a quantity of 0 or 1
only; a record for an item that has no serial number may have any positive
number as its quantity.

Click Apply to save your work and commit the change.

If the item you selected has records in the Redo log, a Redo button appears.
Click Redo to view redo records. In the Redo log, you can delete the records
that are associated with the item. See Deleting a Record on the Redo Log.

Deleting a Record on the Redo Log

The Redo log is a list of recoverable errors and messages that could not be
processed. Some of these errors may be due to incorrect records. You can use the
Adjustment window to correct the quantity for an incorrect record. After the
adjustment, use this procedure to delete the associated record from the Redo log.

Steps

1. pFollowing the procedure for Updating the Quantity in an Existing Record.

2. When the record has been updated, click Redo.
The Redo Log displays a list of incorrect records. Use the scroll bars to see the
entire list.

3. To delete a record, click the checkbox to the left of the record and click Apply.
A message asks you to confirm the new record.

4. Click OK to confirm.

Performing an Inquiry in Network Logistics

Use the following procedure to review item records in Network Logistics that are
give details about Inventory, Assets and Projects.

Prerequisites
All inventory setups, such as organization and item creation, must be completed.
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Submitting a Request

Steps

1.

In the Network Logistics responsibility, navigate to Inquiry.
The Find window appears.

In the Find window, enter an item number, organization, or serial number
associated to the record(s) you want to review.

You must enter an organization before you can enter a serial number.

You may also enter additional search information on the Inventory, In Process,
and Assets/Network tabs. Available fields on these tabs vary, depending on the
information entered in the top of the Find window.

In the Primary Result section of the Find window, choose the type of
information you want to see appear first: Inventory, In Process, Asset/Network,
or Summary.

= Inventory displays information about the item.
= InProcess displays project-related information.
= Assets displays information about the asset number.

= Summary displays the item number, location, status, quantity, lot number
(CLELD), revision, and asset number.

Click Find.

The Item Summary window appears with a list of items that match the
parameters you requested.

See also:

Understanding the Item Summary Window

Submitting a Request

Use the Submit Request window to request one of the following reports and
concurrent processes in Network Logistics:

Network Logistics Assumed Loss Rate Report
Network Logistics Bill of Lading

Network Logistics Error Log Report

Network Logistics Redo Log Report

Network Logistics Recovery Process
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Requesting a Network Logistics Assumed Loss Rate Report

= Import Network Locations
= PRC: Interface Payables Invoice Cost Adjustments to Assets

= PRC: Interface Payables Invoice Cost Adjustments to Projects

Requesting a Network Logistics Assumed Loss Rate Report

Use this procedure to generate a list of items that have been issued to projects but
have never been placed in service.

Prerequisites
None.

Steps
1. Inthe Network Logistics responsibility, navigate to Requests > Run.

2. Choose to run either a single report or a report set.
3. Inthe Name field, choose Network Logistics Assumed Loss Rate Report.
4. Choose either Detail or Summary Report Type.

Detail displays all individual transactions that meet your criteria. Summary
provides only transaction totals.

5. Inthe Parameters window, you may enter information in the fields to define
your search.

If you leave all optional fields blank, the search returns all records across all
organizations in the format you requested.

Project Number. To limit your search results to those items that have been
issued to a specific project, enter the project number here.

Task Number. To further limit your search results to those items that have
been issued to a particular task for a project.

Organization. To limit your results to a particular organization, enter that
organization here.

Inventory Item. To limit your search results to records for a specific item,
enter the item number here.

6. Click OK to close the Parameters window.

7. Click Submit when you have finished defining the report.
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Viewing Request Results

The application assigns an ID number to your request. Use the ID number to
find your request in the View Request form.

See also:

Viewing Request Results

Viewing Request Results

When you request a report, Network Logistics assigns a number to your request,
runs the request and stores the report. Use this procedure to view the report you
requested.

Prerequisite
You must request a report and save the request ID number.

Steps
1. Inthe Network Logistics responsibility, navigate to Requests > View.

2. Inthe Find window, click Specific Request and enter the ID number of the
report you wish to view.

3. Click Find to retrieve the record.
4. Click View Output to see the report online.

If the report was completed with errors, choose View Log to see a list of the
errors that were encountered when your request was processed.

5. To print the report, in the Menu Bar choose Tools > Reprint.
Enter the number of copies to print, the printer, and the print style.

6. Click Save to complete the reprint request.

Requesting a Network Logistics Bill of Lading Report

The bill of lading displays: the move order number; transaction request date; the
ship-to location name and address; the project number; task number; line item
number; item number; item revision; quantity requested and quantity shipped, both
with totals for each item number; CLEI; serial number; and vendor serial number.
Follow these steps to generate a bill of lading.
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Requesting a Network Logistics Bill of Lading Report

Prerequisites
None.

Steps
1. Inthe Network Logistics responsibility, navigate to Requests > Run.

2. Choose to run either a single report or a report set.
3. Inthe Name field, choose Bill of Lading Report.
4

In the Parameters window, you may enter information in the fields to define
your search.

If you leave all fields blank, the report will include all move orders for the
current day.

Move Order Number. To limit the report to a specific move order, enter that
number here.

Organization Name. To limit the report to a specific organization.

Date From. To limit the report to all move orders generated from a specific
date forward, enter that date here.

Date To. To limit the report to all move orders generated before a specific
date, enter that date here.

Project Number. To limit the report to only those move orders for a specific
project, enter that project number here.

Task Number. To limit the report to only those move orders for a particular
project task, enter that task number here.

Location. To limit the report to only those move orders for a particular
physical location, enter that location here.

5. Click OK to close the Parameters window.
6. Click Submit when you have finished defining the report.

The application assigns an ID number to your request. Use the ID number to
find your request in the View Request form.

See also:

Viewing Request Results
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Requesting a Network Logistics Error Log Report

Guidelines

To print a bill of lading for a specific range of dates, enter a date in both Data
Required From and Data Required To. If you do not enter any dates in these fields,
the bill of lading report shows all move orders up to the system date.

If you enter a value for Task Number, enter a corresponding Project Number.

To keep the report results to a manageable length, enter data for as many of the
parameter fields as possible.

Requesting a Network Logistics Error Log Report

Use this procedure to request a report that lists all fatal errors. For each error, the
report displays: the item number, serial number, transaction date, transaction time,
the error message text, and error description.

Prerequisites
None

Steps
1. Inthe Network Logistics responsibility, navigate to Requests > Run.

2. Choose to run either a single report or a report set.

3. Inthe Name field, choose Error Log Report.

4. Inthe Parameters window, enter information that defines your search.
Start Date. Determines the first day in the range of days.
End Date. Determines the last day in the range of days.

Purge Data. To purge data from the Error Log after you have fixed the
error.

Warning: This will purge data whether is has been fixed or not.

5. Click OK to close the Parameters window.
6. Click Submit when you have finished defining the report.

The application assigns an ID number to your request. Use the ID number to
find your request in the View Request form.
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Requesting a Redo Log Report

Guidelines
See also:

Viewing Request Results

Running the Recovery Process

Requesting a Redo Log Report

The Redo Log report shows all recoverable errors. For each error, the report
displays: the item number, the serial number, transaction type, transaction date and
time, and the text of the error message. Use the following procedure to generate a
Redo Log report as part of the Recovery process.

Prerequisites
Suspend the message dequeuer before requesting a Redo Log report.

Steps

1. Inthe Network Logistics responsibility, navigate to Requests > Run.

2. Choose to run either a single report or a report set.

3. Inthe Name field, choose Redo Log Report.

4. Inthe Parameters window, enter dates to limit the results returned.
Start Date. Determines the first day in the range of days.
End Date. Determines the last day in the range of days.

5. Click OK to close the Parameters window.

6. Click Submit when you have finished defining the report.

The application assigns an ID number to your request. Use the ID number to
find your request in the View Request form.

See also:
= Running the Recovery Process

= Viewing Request Results
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Running a Concurrent Program

Guidelines

Disable the message dequeuer before you request a Redo Log report. This action
prevents the addition of new messages to the list while you perform the Recovery
process.

If you do not enter values for Start Date and End Date, the Redo Log displays all
incomplete transactions.

References
See also:

= Understanding the Redo Log

» Understanding the Recovery Process

= Understanding the Message Dequeuer
= Oracle SDP Stop

= Requesting an Error Log Report

Running a Concurrent Program

Network Logistics provides two concurrent programs for transferring invoice cost
adjustments to Assets or Projects:

= PRC: Interface Payables Invoice Cost Adjustments to Assets
= PRC: Interface Payables Invoice Cost Adjustments to Projects

Use this procedure to run a concurrent program.

Steps
1. Inthe Network Logistics responsibility, navigate to Requests > Run.

2. Choose to run either a single report or a report set.
3. Inthe Name field, choose one of the concurrent processes.
4

In the Parameters window, enter information to define the items you want to
include in the process.

Click OK to close the Parameters window.

o

6. Click Submit when you have finished defining the report.
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Finding Personal Profile Values

The application assigns an ID number to your request. Use the ID number to
find your request in the View Request form.

See also:

= Viewing Request Results

Importing Network Locations

A network location, also known as Common Language Location ID (CLLI),
describes the exact geographical position of an asset. You may have a list of network
locations in a legacy system. Use this concurrent request to import network
locations from the legacy system into Network Logistics.

Prerequisites
None.

Steps
1. Inthe Network Logistics responsibility, navigate to Requests > Run.

2. Choose to run either a single report or a report set.
3. Inthe Name field, choose Import Network Locations.
4. Click Submit.

The application assigns an ID number to your request. Use the ID number to
find your request in the View Request form.

See also:

= Viewing Request Results

Finding Personal Profile Values

In the Find Personal Profile Values window, you can search for the personal profile
values that have already been defined in other Oracle modules. Then use the
Personal Profile Values window to display and make changes to your personal
settings. Do not enter user values unless you require a setting that is different from
the default setting.

Follow these steps to find and edit personal profile values used in the Network
Logistics module.
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Finding Personal Profile Values

Prerequisites
Profiles

Steps
1. Inthe Network Logistics responsibility, navigate to Setup > Profiles.

The Find Personal Profile Values window opens.
2. Click [...} to open the list of values.

The Organizations window appears.
3. Enter CUN% in the Find field and click Find.

The Profiles window displays the profiles for Network Logistics.
4. Select the profile you want to edit and click OK.

The Find Personal Profile Values window displays the name of the selected
profile.

5. Click Find.

The Personal Profile Values window opens and displays the selected profile.
6. Enter values in the User Value column to customize the user profile.

You cannot edit a gray field.

7. Select File > Save to save your changes.
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Understanding the Redo Log

Administering Network Logistics

This topic group provides task-based procedures that are required for ongoing
system maintenance and includes information on administration tools and utilities.

Understanding the Redo Log

The Redo Log is a list of recoverable error messages. The application monitors all
transactions and Workforce Management System (WMS) messages to compile the
Redo Log.

A recoverable error occurs as a result of an incorrect transaction. A transaction may
cause a recoverable error for a number of reasons, for example, when:

= Theitem record is missing required data
= The status of the item record is incorrect
= The transaction requires an item that has an incomplete transaction status

= Thetransaction has been initiated but requires some additional user action to be
completed

Any WMS messages subsequent to the Incomplete transaction that are related to the
same item are also saved on the Redo Log.

Transaction Status Recoverable (R) or Incomplete (1)

When a transaction is incomplete, it has a status of either Incomplete (I) or
Recoverable (R).

If the transaction status is Recoverable, then Network Logistics cannot perform the
transaction because of a recoverable error. A recoverable error may be caused by:

= Anundefined attribute, such as a missing asset category

= A pre-existing incomplete transaction for the item that prevents a second
transaction

= A transaction that requires a quantity of item that exceeds the quantity available

When you correct the problem that caused the recoverable error and run the
Recovery process, the status of the transaction becomes Complete (C).
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Understanding the Redo Log

When the status is Incomplete, it indicates that Network Logistics cannot perform
the transaction because some action needs to be completed in a module outside of
Network Logistics. When the action is performed, you can run the Recovery process
to change the status of the transaction to Complete.

Each Transaction Generates a Message

Every transaction of a trackable item generates a message to the application. When
the application receives a message, it searches the Network Logistics tables for a
record of the item. If it finds the record and all the attributes have been defined in
the record, the transaction occurs without errors.

However, when a transaction results in an error, the related message is sent to the
appropriate log. For example, if a Receipt-to-Project transaction of a normal item is
missing attributes for category or location, a fatal error occurs. The message that is
sent as a result of this transaction is sent to the Error Log.

Fatal Errors on Error Log

The Error Log is a list of messages that were sent to Network Logistics for
transactions that caused fatal errors. Often these transactions involve items for
which Network Logistics cannot find a record. The Error Log may also contain a
few messages for transactions that caused recoverable errors.

For example, a fatal error occurs if a receipt transaction involves a depreciable item
and the item location has not been defined. When a receipt transaction for a
depreciable item generates a fatal error, each subsequent transaction of the item will
result in a recoverable error. The receipt transaction must be corrected to prevent
the accumulation of additional errors.

Transaction Status Complete (C)

The application changes the status of a transaction to Complete (C), when the
following conditions are met:

= The transaction has not generated any errors

= Thetransaction is complete

= The transaction is not dependent on another incomplete transaction
See also:

= Understanding the Network Logistics Recovery Process

= Deleting a Record on the Redo Log
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Understanding the Network Logistics Recovery Process

Understanding the Message Dequeuer

A message dequeuer is a background process that continuously polls a queue and
processes the items from the queue. The message dequeuer removes messages from
the message queue on a first-in, first-out (FIFO) basis. Message queues are
maintained by Oracle Advanced Queueing (OAQ). For information about message
gueues, see also:

= The Oracle Provisioning System Queues
= Administering the System Queues
= Managing the System Queues

You can manage the message queues in either Oracle Provisioning or Oracle
Number Portability. Network Logistics uses the messaging system that is
maintained in Service Delivery Platform (SDP). For more information about the
messaging system, see Using the iMessage Studio.

When you start a message queue, a controller process automatically starts the
dequeuers. For more information about starting and suspending a message queue,
see:

= Oracle SDP Start
= Oracle SDP Stop

Understanding the Network Logistics Recovery Process

Run the Recovery process to clear the Redo Log of recoverable errors. During the
Recovery process, the application attempts to process each message in the Redo Log
in chronological order.

Before running the Recovery process, you must suspend the inbound message
queue dequeuer. This keeps it from recording more messages during the Recovery
process. For information about the message dequeuer, see Understanding the
Message Dequeuer.

First, the Redo Log and Error Log Reports

After suspending the message dequeuer, run the Redo Log Report and the Error
Log Report. These reports show the error messages that are currently pending.

You may be able to correct some of the incomplete transactions on the Redo Log by
correcting faulty item setups or providing additional data in the transaction. When
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Running the Recovery Process

you run the Recovery process, the message associated to the corrected transaction is
removed from the Redo Log.

You may also find some recoverable errors on the Error Log Report.
See also:
= Requesting a Network Logistics Redo Log Report

= Requesting a Network Logistics Error Log Report

Next, the Recovery Process

After correcting transactions, run the Recovery Process, a concurrent program. This
process attempts to:

= Reprocess all messages in the Redo Log

= Update all transactions that have a status of R

If the problem that originally caused a recoverable error has been corrected, the
transaction status is updated to Complete (C). The Recovery process executes each
message related to the transaction.

If the recoverable error has not been corrected, then the transaction cannot be
completed. The transaction status remains Recoverable (R) and any subsequent
message for the unit is not processed.

The Recovery process generates a Recovery Execution Report that displays those
messages that still have not been processed.

Repeat Until Redo Log is Cleared

At the end of the Recovery process, a notification tells you to restart the message
dequeuer. To completely clear the Redo Log, you may need to repeat the Recovery
process until all messages are processed successfully.

Running the Recovery Process

Use the Recovery process to clear the Redo Log of the messages that are associated
with recoverable errors. Before you run the Recovery process, you request the
Network Logistics Redo Log Report and the Network Logistics Error Log Report to
find and then fix all the recoverable errors. Then the Recovery process attempts to
process all the messages and clear the errors.

Follow these steps to run the Network Logistics Recovery Process.
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Running the Recovery Process

Prerequisites

None.

Steps

1. Inthe OP System Administrator Navigator, choose Administration > Queue
Console.
You may also start in the NP System Administrator responsibility.

2. Select the Inbound Message Queue from the list of queues and click Suspend.
The Queue Status changes to Suspended.

3. Inthe Network Logistics responsibility, request the Redo Log Report and the
Error Log Report.

4. When the reports are completed and normal, click View Output.

5. Onthe Redo Log report, review each message. Identify and correct all errors
that can be manually fixed.
These errors include missing attributes and unfinished user actions. Check the
Error Log Report for errors that share the same message ID as the errors on the
Redo Log Report.

6. Inthe Network Logistics responsibility, navigate to Requests > Run.

7. Inthe Name field, choose Recovery process and click Submit.
The application assigns an ID number to your request. Use the ID number to
find your request in the Requests window.

8. When the report is completed and normal, click View Output.

9. Review the report. Identify and correct all errors that can be manually fixed.

10. Repeat steps 2 through 9 until the Recovery Execution Report is cleared of

messages.
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Running the Recovery Process
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